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Getting Started

Introduction

Pocket LABELVIEW™ is an application that allows you to take
labels created in LABELVIEW™ label design software,
download them to your Windows® CE/Pocket PC device, and
print them using a direct or network/wireless connection.
Pocket LABELVIEW supports standard types of label content,
including text, bar codes, graphics and more. Pocket
LABELVIEW also allows you to access data from variable data
sources including database, serialization and prompted fields.

This guide is designed to provide you with the basic
information you need to install and activate Pocket
LABELVIEW, download labels to your Windows CE/Pocket PC
device, use Pocket LABELVIEW to enter or edit variable data,
and print labels using a direct or network/wireless connection.

Usage Requirements

The following software and hardware components are required
in order to use Pocket LABELVIEW.

• LABELVIEW Gold version 7.02 or higher label design soft-
ware (includes one Pocket LABELVIEW license) installed on 
the host computer OR LABELVIEW Pro version 7.02 or 
higher and a Pocket LABELVIEW add-on license installed 
on the host computer

• Supported Windows CE/Pocket PC device

• Microsoft® ActiveSync® synchronization software v3.5 or 
higher (included with all Microsoft Windows powered 
Pocket PCs), installed on the host computer

e
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Installing and Activating Pocket LABELVIEW
1 Connect your Pocket PC device to your host computer.

2 Ensure that an ActiveSync partnership is established 
between them.

3 On the host computer, start the LABELVIEW label design 
software.

4 On the Options menu, click Configuration, and then 
click the PRINTPAD / Pocket LABELVIEW tab.

Figure 1-1  PRINTPAD / Pocket LABELVIEW Tab

5 Under the Platform options, click Pocket LABELVIEW 
and then select your Windows CE/Pocket PC device from 
the Model drop-down list.

If your exact model is not listed, try selecting the generic 
processor type (e.g., StrongARM, MIPS, or SH3) that 
applies to your model.

Note You can click the  button to view information on features 
supported by Pocket LABELVIEW. For additional information, 
see the Designing Labels for Pocket LABELVIEW chapter.
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6 Click the Activate button to access the Pocket LABELVIEW 
Activation Manager.

7 A message appears asking if you want to install Pocket 
LABELVIEW now. Click Yes.

The Pocket LABELVIEW Installation dialog box 
appears.

Figure 1-2  Pocket LABELVIEW Installation

8 Select your Windows CE/Pocket PC model from the 
Pocket PC to install drop-down list.

9 Click Install Pocket LABELVIEW Now.

The Activation Manager will install Pocket LABELVIEW on 
the Windows CE/Pocket PC device.

10 Now start the Pocket LABELVIEW application on the Win-
dows CE/Pocket PC device. (You must run Pocket LABEL-
VIEW on the device at least once before you can activate 
the program.)

A message will appear to inform you that Pocket LABEL-
VIEW will run in demo mode. This is correct because you 
have not yet activated Pocket LABELVIEW.
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Pocket LABELVIEW Main Menu Options

When you start the Pocket LABELVIEW application on your
Windows CE/Pocket PC device, the Main Menu will appear. The
Pocket LABELVIEW Main Menu allows you to access all
program functions and configuration settings. 

Figure 1-3  Pocket LABELVIEW Main Menu

Overview of Main Menu Options:

• Print Labels: Select a label for printing, enter any vari-
able data required, print labels or send labels to a queue 
for printing at a later time.

• Monitor Command File: Monitor command files for 
changes. When changes appear, the system executes the 
command files and prints the labels automatically.

• Update Serial #: Edit the value of a serial file (.srl file) 
used with your label design files.

• Configuration: Set up TCP/IP ports, label download con-
nection, or command file configuration.

• Download Labels: Use a wireless connection to transfer 
selected label files to the Windows CE/Pocket PC device. 
This allows you to receive labels from the host PC without  
needing to have the device docked in its cradle.
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Note You can double-click the Pocket LABELVIEW text at the top 
of the Main Menu to display Pocket LABELVIEW system status 
information.
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LABELVIEW

Setting Up a Label in LABELVIEW 

Selecting a 
Printer

The LABELVIEW label design software contains hundreds of
printer drivers for thermal/thermal transfer printers from
many thermal printer manufacturers. These printer drivers are
loaded on your computer when the program is installed. 

When setting up a new label, you must select a natively
supported printer in the LABELVIEW program. Pocket
LABELVIEW prints only to printers that are natively supported
by LABELVIEW.

X To install a printer in LABELVIEW:

1 On the File menu, click Select Printer, and then click 
Install.

2 Using the Available Printer Drivers lists, select the 
manufacturer and model of a natively supported printer 
(designated by a “(V)” appearing after the printer name).

3 With the desired printer selected, click Install.

The printer driver appears in the Installed Printers list 
on the Install Printer Drivers dialog box.

Note
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Figure 2-1  Install Native Printer Driver

4 Click Connect and select the port to use for printing and 
adjust the settings, if necessary, according to your printer 
documentation.

If the printer is connected to a serial port, click the Set-
ting button to configure the driver to match the printer 
device settings (baud rate, data bits, stop bits, parity, flow 
control). The printer and the computer MUST be set to 
exactly the same values. Check your printer documenta-
tion for the correct settings.

5 Click OK, Close, and OK to return to the design window.

X To select a previously installed printer in 
LABELVIEW:

1 On the File menu, click Select Printer.

2 Click the Printer drop-down arrow to display a list of 
installed printers.

3 Select a natively supported printer (designated by a “(V)” 
appearing after the printer name), and click OK.
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Designing a Label Using the LABELVIEW label design software, you can design
labels to meet most any industry specification or compliance
labeling requirements. See the LABELVIEW Quick Start Guide
or Help for information on designing a label. 

Pocket LABELVIEW supports all standard types of label
content, including text, bar codes, graphics and variable data
including database (dBase), serialization and prompted fields. 

The following table summarizes the variable data features
supported by Pocket LABELVIEW.

Feature Description Benefit

“When Printed” 
Fields

Prompt the user for the 
field value at print time.

Useful for entering data 
that changes from label to 
label, such as the customer 
and purchase order data on 
a shipping label.

Date and Time 
Fields

Date and Time fields are 
retrieved from the Windows 
CE terminal's system clock 
when the label is printed.

Allows easy time and date 
stamping. For example, 
you can print “Best Used 
By” labels or print a date/
time stamp on labels to 
help track employee shift 
changes.

Formula Fields
Use mathematical calcula-
tions to manipulate and 
concatenate fields.

Useful for common label 
elements such as expira-
tion dates and box counts 
(Box 1 of 10, Box 2 of 10, 
etc.)

Database Fields
Access data from dBase 
databases.

Offers a greater level of 
accuracy and efficiency for 
populating fields with data. 
Locally stores database 
files for mobile conve-
nience.

Serialized 
Fields

A serial file is used to track 
the number of labels 
printed so that for the next 
print job, counting can con-
tinue with the next value in 
the series. Serial file val-
ues can be updated/reset 
using Pocket LABELVIEW.

Print sequential numbers 
such as serial numbers, 
shelf numbers, coupon/
ticket numbers, etc.
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For information on the label design and printing features that
are available with Pocket LABELVIEW, see Appendix A—Pocket
LABELVIEW Feature Comparison in this guide.
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LABELVIEW

Pocket LABELVIEW offers two options for downloading labels to
the Windows CE/Pocket PC device:

• Standard download (with device in its cradle)

• Network download (for network/wireless connections)

For both types of downloads, all files associated with the label
design (e.g., serial files, database files, etc.) are automatically
downloaded along with the label files in the download process.

Standard Download

The standard download procedure is used for most typical
direct label printing applications. With this method you simply
download the labels via LABELVIEW with your Windows CE/
Pocket PC device in its cradle, and then LABELVIEW uses
ActiveSync to transfer the files to your Windows CE/Pocket PC
device. 

1 In LABELVIEW, on the File menu, click Download Label 
to Pocket LABELVIEW.

The Download Label to Pocket LABELVIEW dialog box 
appears.

Note
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Figure 3-1  Download Labels to Pocket LABELVIEW

2 Click the Select Dir button and specify the directory 
where the labels are saved.

3 To select a single label to download, click on the label 
name and then click Add to move the label to the 
Selected Labels box.

4 To select all labels in the directory, click Add All to move 
all labels to the Selected Labels box. 

5 Once all desired labels appear in the Selected Labels 
box, click Download.

6 Specify the directory in which you want to store the files 
and click OK.

A Data subfolder will be created within the specified direc-
tory. The selected labels and all associated files will be 
optimized for transfer and placed in this Data folder. The 
folder will act as a temporary storage bin for your label 
formats as they are automatically downloaded to your 
Windows CE/Pocket PC device.
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Network Download

Pocket LABELVIEW allows you to download label design files
over a wireless network using the Windows Networking
Protocol. This is especially useful in situations where multiple
devices are being used for the same application and printing
the same label.

Note The following steps assume you have already successfully set 
up your Pocket PC device to connect to your network.

1 Using Windows Networking, create a shared folder/drive 
on the server — all labels will be stored in this shared 
folder. (For information on setting up a shared folder or 
drive, refer to Windows Help.)

2 Follow steps 1-5 of the previous Standard Download sec-
tion to select labels for download.

3 When specifying the directory in which you want to store 
the files, select the shared folder you created previously 
and click OK.

The selected labels and all associated files will be opti-
mized for transfer and placed in the specified directory.

4 On the Pocket LABELVIEW Main Menu, click Download 
Labels.

The network download settings appear.
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Figure 3-2  Network Download Settings

5 In the Server box, enter the full UNC path of the shared 
folder using the following syntax:

\\PCName\SharedFolderName

6 Enter the user ID and password required to connect to the 
host PC. 

7 Click Login. 

After connecting, all label files in the shared folder will 
appear. 

8 Select the file or files you want to download and click 
Download Now. 

The selected files will be transferred to Pocket LABEL-
VIEW's Data folder on the Windows CE/Pocket PC.

Removing Labels from the Windows CE/Pocket PC 
Device

To remove previously downloaded labels from your Windows
CE/Pocket PC device, you will need to manually delete them
from the Pocket LABELVIEW Data subfolder using Windows
Explorer.



4

Updating Fields and Printing Labels

Updating Serial File Fields

If your label uses serial files, you can update the value of the
serial (.srl) file after you have downloaded the labels to the
Windows CE/Pocket PC device using Pocket LABELVIEW. 

X To update serial files:

1 On the Pocket LABELVIEW Main Menu, click Update 
Serial #. The serial file editing screen appears.

Figure 4-1  Edit Serial File

Note
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2 Highlight the serial file name and click Load (or double-
click the file name). 

The current serial value will appear in the edit box.

3 To update the serial value, type the new value in the edit 
box and click the Save button on this screen.

Printing Labels

Note If you plan to print labels using a wireless TCP/IP connection, 
see the Printing Via a Network or Wireless Connection section 
later in this chapter for information on adding a TCP/IP port in 
Pocket LABELVIEW.

1 On the Pocket LABELVIEW Main Menu, click Print Labels.

The Pocket LABELVIEW print settings appear.

Figure 4-2  Pocket LABELVIEW Print Settings

2 At the top of the print settings screen, click the drop-down 
arrow to display a list of all downloaded labels.

3 Select the label to print.
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If the label contains variable data fields, the associated 
prompts and field values will appear.

4 For labels containing When Printed fields, double-tap the 
prompt for a When Printed field. 

A text box will appear in the row, allowing you to input 
your When Printed field value.

5 For labels containing database fields, double-tap the 
prompt for a field that is tied to a database.

The database appears in a grid view.

Figure 4-3  View Database

Select the key field (the first prompted field) to use for the 
database.

6 In the Quantity box, specify the label quantity to print.

7 From the Port drop-down list, select the port to use for 
printing.

8 Click Print.

Note To print labels through Pocket LABELVIEW, you must print to 
a natively supported printer, designated by a (V) appearing 
after the printer name in the LABELVIEW program.
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Printing Via a Network or Wireless Connection 

Pocket LABELVIEW allows you to print labels to a printer on
your network or take advantage of wireless printing to printers
across the globe using a TCP/IP connection. If you are running
Pocket LABELVIEW on a wireless enabled Windows CE/Pocket
PC, all you need is a wireless access point and you can connect
the Windows CE/Pocket PC to the wired network. Once that
connection is made, you will be able to print to any TCP/IP
addressable printer on the network.

In order to set up a network printer to print your labels, you
must first add the TCP/IP ports in Pocket LABELVIEW. 

Note The following steps assume you have already successfully set 
up your Pocket PC device to connect to your network and that 
the TCP/IP port is working.

X To add a TCP/IP Port:

1 On the Pocket LABELVIEW Main Menu, click Configura-
tion.

The TCP/IP configuration settings appear.

Figure 4-4  Add TCP/IP Port

2 Click Add to display the TCP/IP port settings.
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Figure 4-5  TCP/IP Port Settings

3 In the Name box, type a name for the printer (e.g.,“Ship-
ping Printer” or “Production Printer”). 

The name is used as an alias. If left blank, Pocket LABEL-
VIEW will assign a name based on the IP address such as  
“IP_172.20.130.30”.

4 In the IP Address box, type the IP address of the printer 
or print queue.

5 In the Port Number box, type the number of the port 
used by the TCP/IP socket communication. 

In most cases the port number is 9100 or 9600. (Do not 
confuse this with the LPT1 port or COM1 port.)

6 Click OK.

The port will be listed on the TCP/IP Ports screen and will 
now be available for selection when printing.
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Queuing Print Jobs

Pocket LABELVIEW can also be used in a batch mode, allowing
you to queue your print jobs for printing at a later time. 

X To send print jobs to a queue:

1 On the print settings screen, click the Port drop-arrow 
and select the appropriate output port.

2 Click the Queue print jobs check box. 

Figure 4-6  Queue Print Jobs

3 Click Print to save your print jobs to Pocket LABELVIEW’s 
Data folder.

X To print all queued print jobs:

1 Clear the Queue print jobs check box and click Print. 

2 Pocket LABELVIEW will display the message, “Do you want 
to send all print jobs now?”. Click Yes.

All queued print jobs will be sent to the selected port 
(Com1 or any selected TCP/IP port).
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Labels Automatically

What is a Command File?

A command file is a simple instruction file that can be used to
print labels automatically. You specify the name of a folder to
be monitored, and the system checks for the existence of a
command file (.cmd file) based on the time interval specified.
When a command file is detected in the folder, the system
processes the command file and prints the labels. All command
files in the monitored folder are deleted after printing.

A command file contains commands that identify the name of
the label, the printer to use, and the label quantity. Variable
data can be provided in the command file, or it may be
provided in a separate data file. A command file is an ASCII
text file that can be created with any text editor. Command
files have a .cmd file extension. A sample Pocket LABELVIEW
command file might look like this:

 LABELNAME=Shipping.lbl

 PRINTER="192.168.1.102,9100"

 TEXT1="xxxxxxxxxx"
 TEXT2="yyyyyyyyyy"

 BARCODE1="12345678"

Command files can also be used to pass information generated
by other systems and possibly other computers, including
mainframes or mini-computers. For example, an invoicing
program could pass information into a command file, which
would in turn print a label.

Note
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Setting Up a Command File
1 On the Pocket LABELVIEW Main Menu, click Configura-

tion, and then click the Command File tab.

The command file setup screen appears.

Figure 5-1 Configure Command File

2 For the Folder to Monitor setting, click the browse  

button to select the path to the folder that will contain the 
command files. 

The Folder to Monitor can be either a local folder on the 
Windows CE/Pocket PC device or a shared folder on the 
network. To set the Folder to Monitor as a path to a 
shared-out folder on the network (e.g., 
\\myhostpc\mydata), manually enter the network path 
(the browse button cannot be used to browse a network 
path). Note: To use a shared-out folder on the network, 
you must have write permissions for that folder.

3 Set the following options as appropriate for your labeling 
application:

Default Port: Default port used for printing if the 
PRINTER command is not given in your command file.
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Timed Interval (in seconds): How often the directory is 
monitored for changes.

Process File By: Determines the order in which files are 
processed.

• Date Time: Processing is based on when the file was 
created (oldest first).

• File Name: Files are processed in alphabetical order.

Backup before deleting (BAK): Saves a backup copy of 
each command file after printing takes place.

Stop processing on error: If an error occurs while print-
ing a label, it will stop the print job and prevent printing 
the remaining labels in the file. For example, a misspelled 
field name will end the print job.

Log error to file: Logs any errors encountered during the 
execution of the command file. The file (named 
CMDFILE.ERR) can be found in the same directory as the 
command file.

4 Click OK to return to the Main Menu.

Writing Command Files

Command File 
Formatting

There are many commands that can be issued in command
files. Follow these guidelines when writing the command file:

• Be careful to include the spaces.

• Using quotation marks (" ") around field names is 
optional, unless you are adding spaces in the fields.

• A semicolon ( ; ) indicates remarks or comment state-
ments; characters that appear after a semi-colon will be 
ignored.

• Command files are NOT case sensitive.

Sequence of 
Commands

The LABELNAME command identifies the name of the label to
print, and must be the first line in any command file. It can,
however, appear multiple times in a command file specifying
different labels to print each time.

The LABELQUANTITY command specifies the number of labels
to print, and should be the last line for each label to be printed
from the command file, since it is the active command. The
label prints when this command is encountered. If omitted,
then only one label will print.
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Command File Commands

LABELNAME

The LABELNAME command identifies the name of the label to
print, and must be the first line in any command file. It can,
however, appear multiple times in a command file specifying
different labels to print each time.

If the same label is being printed more than once in the same
command file, it is not necessary to repeat this command. The
program will reprint the last label with the new data and
quantity.

For Pocket LABELVIEW command files, the label name must
match the name of the label file after it has been downloaded.
This means that the label name must be specified using the
short (eight character) file name convention, with or without
the file extension. Give only the label name, NOT the full path
to the file. For example, if you create a label in LABELVIEW
named "Acme parts", when downloaded to Pocket LABELVIEW
this file name will become "Acmepa~1", and so for the
LABELNAME command you would need to give the following:

LABELNAME=Acmepa~1

FIELD_NAME

For each variable data field (When Printed or database) on the
label, there should be a statement in the command file that
assigns it a value. The value for FIELD_NAME in the command
file must match exactly the name of the field in the label; the
variable data should appear after the equal sign within
quotation marks.

For database key data fields, the name of the key data field on
the label should be the same as its name in the database. If
more than one label is being processed in the same command
file, leaving a field name blank results in the last assigned
value for that name being reused. To leave a field blank, insert
a null character (two quotes with nothing in between, "" ) into
the string. For example:

PART_NUM = "836773” 
COMPANY=""
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PRINTER

The PRINTER command is an optional command that identifies
which printer port to use. If the PRINTER command is omitted,
Pocket LABELVIEW will use the default port, defined during
command file setup.

The port can be expressed in any of the following three ways,
depending on your printer/port setup:

• If the printer is on COM1, enter the following:

PRINTER="COM1"

• If the printer is on an IP address and port, enter the IP 
address and port number separated by a comma. For 
example: 

PRINTER="192.168.1.102,9100"

• You can also specify the printer port by giving the port 
name you previously defined on the TCP/IP Ports setup 
screen. Enter the Name exactly as it appears on the TCP/
IP Ports screen. For example:

PRINTER="DMX 4206"

Note Many Pocket PC devices have only a USB port. The procedure 
for configuring USB as COM1 depends on your particular 
Pocket PC model, and may require a special cable and driver. 
See your Pocket PC device documentation for information on 
port configuration.

LABELQUANTITY

The LABELQUANTITY command specifies the number of labels
to print, and should be the last line for each label to be printed
from the command file, since it is the active command. The
label prints when this command is encountered. If omitted,
then only one label will print.

Do not include this command if you are using data files; one
label or group of labels will be printed for each line of data. For
example:

LABELQUANTITY=5
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Monitoring Command Files

Once the command file settings have been configured, you can
begin to monitor the command file folder for changes.

X To monitor command files:

• On the Pocket LABELVIEW Main Menu, click Monitor
Command File.

The program will begin to monitor the specified folder for 
changes. When a change occurs, all command files in the 
folder will be executed in order.

Figure 5-2 Monitor Command Files

Pocket LABELVIEW’s Monitor Command File screen will 
update to display a log of all processed command files, 
giving the time of processing, file name, and status (OK, 
Waiting, etc.)

X To cancel the monitoring process:

• Click the Stop button on the Monitor Command File screen
to cancel the monitoring process.
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A

Comparison

Most, but not all, LABELVIEW functions are supported when printing from Pocket
LABELVIEW. Teklynx is continually updating and adding new features to make
Pocket LABELVIEW's printing capabilities equal to the printing capabilities of the
LABELVIEW software.

This table lists all the LABELVIEW features; a check mark indicates the program
supports the feature.

* Datamax, Microcom, and Zebra printers can support variable TrueType fonts from
Pocket LABELVIEW.

Feature
Printing with 
LABELVIEW 
Gold (PC)

Printing with 
Pocket 

LABELVIEW 
(Pocket PC)

Text

Printer resident fonts – fixed data a a

TrueType fonts – fixed data a a

Printer resident fonts – variable data a a

TrueType fonts – variable data a *
Left justification a a

Center justification a

Right justification a

Note
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(Table continued from previous page)

Feature
Printing with 
LABELVIEW 
Gold (PC)

Printing with 
Pocket 

LABELVIEW 
(Pocket PC)

Bar Codes

All one dimensional bar codes a a

2D bar codes  - Fixed data a a

Variable PDF-417 (for printers that 
support the symbology)

a a

Paragraphs

Fixed paragraphs (using printer or 
TrueType fonts)

a a

Variable paragraphs (database) a

Graphics, Lines, Boxes

Fixed graphics (PCX, BMP, TIF, JPG) a a

Variable graphics (from database) a

Boxes a a

Lines a a

Data Sources

Fixed a a

When Printed a a

Linked a a

Database a a

Date/Time stamp a a

Serial files a a
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Data Sources (continued)

Accumulator files a

Pick List a

CommWatch a a

Incrementing

Printer a a

Software a a

Hexadecimal a a

Other Features

Password security a

Logging files a

Label Select a

Command files a a

DataWatch a

(Table continued from previous page)

Feature
Printing with 
LABELVIEW 
Gold (PC)

Printing with 
Pocket 

LABELVIEW 
(Pocket PC)



  

Inputting Data Using the Symbol 

B

2800 Pocket PC

If you are using Pocket LABELVIEW with a Symbol 2800 Pocket
PC, you can take advantage of the built-in bar code scanner
features on the Symbol 2800 Pocket PC. Specifically, the Scan
Barcode button (large yellow button near the top of the
device) on the Symbol 2800 Pocket PC allows you to scan a bar
code and automatically input that data into a variable field on
your label.

X To input variable data using the Scan Barcode 
button:

1 On the Pocket LABELVIEW Main Menu, click Print Labels.

2 At the top of the printing dialog, click the drop-down arrow 
to display a list of all downloaded labels.

3 Select the label to print.

The associated variable data prompts and field values will 
appear.

4 In the label's Field Value column, highlight the row into 
which you want to place the scanned data.

5 Press the large yellow Scan Barcode button on the Sym-
bol 2800 Pocket PC.

If the scanner is able to read the bar code data success-
fully, the scanned data will be placed in the highlighted 
variable field. 

Note
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